
O‘ZBEKISTON RESPUBLIKASI                                         

OLIY TA’LIM, FAN VA INNOVATSIYALAR VAZIRLIGI 

 

 

GULISTON DAVLAT UNIVERSITETI 

 

 

“AXBOROT TEXNOLOGIYALARI” kafedrasi 
 

 

 

Z.T. NEGMATULLOYEV 

 

Kompyuter grafikasi 

va vizuallashtirish 

fanidan laboratoriya mashg‘ulotlarini bajarish bo‘yicha 

U S L U B I Y   K O‘ R S A T M A 

 
 

 

 

 

 

 

 

 

 

 

 

Guliston – 2024 



2 

 

UDK: 004.7 

KBK: 32.973 

Yu- 31 

Z.T. Negmatulloyev. “Kompyuter grafikasi va vizuallashtirish” fanidan 

laboratoriya mashg‘ulotlarini bajarish bo‘yicha uslubiy ko‘rsatma, Guliston sh, 2024 

yil, 80 bet. 

Ushbu uslubiy ko‘rsatma amaldagi dasturlar asosida tayyorlangan bo‘lib, 

60110600 – “Matematika va informatika” sirtqi ta’lim yo‘nalishida tahsil olayotgan 

4 kurs talabalari uchun mo‘ljallangan.  

Unda zamonaviy pedagogik texnologiyalar tizimiga asoslangan holda nazariy 

materiallar, amaliy ishlarni bajarish uchun uslubiy talablar va topshiriqlar, bilimlarni 

nazorat qilish uchun savollar majmuasi kabilar keltirilgan. Shuningdek web 

dasturlash va dizayn masalalarini yechishda, WEB saxifalar yaratish, ma’lumotlar 

bazalalari bilan ishlash masalalarini qamrab oladi. Bu uslubiy ko‘rsatmaning 

maqsadi tinglovchilarga ta’lim standartida talab qilingan bilimlar, ko‘nikmalar va 

tajribalar darajasini ta’minlashdir. 

 

Ushbu uslubiy ko‘rsatma Guliston davlat universiteti O‘quv – uslubiy 

Kengashi tomonidan («___»________2024 y. dagi, №___sonli bayonnoma) 

nashrga tavsiya etilgan. 

 

Ushbu uslubiy ko‘rsatma Axborot texnologiyalari kafedrasining 2024-yildagi 

________dagi ___-sonli yig‘ilishida maqullangan. 

 

Axborot texnologiyalari va fizika-matematika fakultet uslubiy kengashining 

2024 yildagi _________dagi ___-sonli qarori bilan muhokama etilib foydalanishga 

tavsiya etilgan. 

 
Taqrizchilar:  Niyozov M.B., Guliston davlat pedagogika 

instituti Aniq fanlar kafedrasi mudiri, pedagogika 

fanlari falsafa doctori (PhD), dotsent. 

   

  Abduraximov D.B., Guliston davlat universiteti 

Amaliy matematika va axborot texnologiyalari 

kafedrasi dotsenti, pedagogika fanlari nomzodi, dotsent 

 

 

 



3 

 

© GulDU, 2024 y. 

SO‘Z BOSHI 

 

"Kompyuter grafikasi va vizuallashtirish" faniga muallif so‘z boshi, barcha 

kompyuter grafika va vizuallashtirish sohalari haqida umumiy tushuncha va nazariy 

bilimlarni o‘z ichiga oladi. Bu fan, kompyuterlarning tasavvurlar, tasvirlar, 

animatsiyalar, va boshqa vizuallashtirilgan ma’lumotlarni yaratish, tahlil qilish, va 

ulardan foydalanishni o‘rgatadi. 

Bu fan, grafik dizayn, animatsiya, model olish (3D modelleme), san’atiy 

tasavvurlar yaratish, tahrir qilish, va boshqa muammolar yechishda kompyuter 

grafikasi va vizuallashtirishning asosiy asoslari va texnologiyalari bilan 

shug‘ullanadi. 

Muallif so‘z boshida, o‘qituvchilar va talabalar o‘zlarini bu sohaga 

ilg‘orlashadi, sohaning eng muhim mazmunlarini o‘rganadi va amaliyotda ishlab 

chiqish bilan tanishadi. Bu fan, barcha sohada faoliyat ko‘rsatuvchi, chiziqchi, 

dizayner, animator, va boshqa soha mutaxassislarini tayyorlash uchun 

umumlashtirilgan bo‘lib, soha bo‘yicha yetuk va mustaqil ishlab chiqishga 

tayyorlashni maqsad qiladi. 

"Kompyuter grafikasi va vizuallashtirish, san’atiy dizayn va raqamli 

tasvirlovchilik sohalarining ahamiyatli va dinamik fanidir. Bu soha, boshqa 

sohalarning chegaralanmagan kreativ va texnologik imkoniyatlarini ko‘zlab chiqadi. 

O‘quvchilarga, kompyuter grafikasi va vizuallashtirish bo‘yicha malakali va 

zamonaviy texnologiyalarni o‘rganish, 3D modelleme, animatsiya, dizayn, va 

boshqa muammolarni hal qilish jarayonlarini tushuntirish, shuningdek, xalqaro 

tajribani oshirish, ularni innovatsion yondashuv va yaratishga chaqiradi. Bu fan 

orqali o‘quvchilar, sohani tushunish, muvofiq texnikalarni o‘rganish va ularni 

amaliyotda samarali vaqt o‘tkazish orqali soha bo‘yicha mutaxassislikni 

rivojlantirishlari uchun tayyorlanishadi." 
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KIRISH  

Laboratoriya ishlarini bajarish bo‘yicha ushbu ko‘rsatmalar kafedra 

o‘qituvchilari tomonidan Kompyuter grafikasi va web dizayn fanidan laboratoriya 

ishlarini tezda o‘zlashtirish va kafedralarning ish rejalariga muvofiq laboratoriya 

ishlarini bajarish uchun zarur uslubiy materiallarni ishlab chiqish uchun 

mo‘ljallangan. 

"Kompyuter grafikasi va vizuallashtirish, san’atiy tasavvurlar, grafik dizayn, 

animatsiya, va 3D modelleme sohalarini o‘z ichiga olgan, kompyuterlar orqali 

tasvirlar, videolar, va boshqa vizuallashtirilgan ma’lumotlar yaratishda 

foydalaniladigan dinamik va kreativ fan. Bu soha, texnologik rivojlanish, kreativlik, 

va dizaynning zamonaviy yondashuvi asosida o‘rganiladi. O‘quvchilar, bu fanning 

ilmiy, nazariy, va amaliy asoslarini o‘rganish orqali, kompyuter grafikasi va 

vizuallashtirish sohasida mutaxassislikni rivojlantirishadi." 

Bu boshlang‘ich so‘z o‘quvchilarga fanning asosiy mazmuni, maqsadi, va 

ahamiyatini ta’kidlaydi. So‘nggi qismlarda, asosiy mavzular, texnikalar, va turli 

soha bo‘yicha tafsilotlar qo‘shiladi. 

Bu kurs, kompyuter grafikasi va vizuallashtirish sohasining asosiy 

tushunchalarini, texnikalarini, va amaliyotni o‘rgatishni maqsad qiladi. O‘quvchilar, 

grafik dizayn, animatsiya, va 3D modelleme bo‘yicha asosiy prinsiplarni o‘rganib, 

ularni amaliyotda qo‘llash orqali, sohaga tayyorgarlik olishlari kutilmoqda. 

Bu kurs, kompyuter grafikasi va vizuallashtirish sohasiga kirish uchun 

boshlang‘ich darajada, shu jumladan, boshqaruv, dizayn, animatsiya, va 3D 

modelleme sohalari bo‘yicha ilmiy bilimlarni rivojlantirishni o‘rgatishga yo‘l 

qo‘ymoqda. O‘quvchilar, kurs yakunlandiqdan so‘ng, savol-javob sessiyalari va 

dastur yakunlash mashg‘ulotlari orqali mustaqil ravishda qo‘shimcha bilimlarini 

oshirib, sohada muvaffaqiyatli ishlashga tayyorlanishlari maqsad qilinmoqda. 
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LABORATORIYA ISHLARINI O‘TKAZISHDA TEXNIKA XAVFSIZLIGI 

BO‘YICHA QISQACHA QOIDALAR 

Hurmatli talabalar’ “Amaliy matematika va axborot texnologiyalari” 

kafedrasiga ta’luqli fanlar professor-o‘qituvchilar tomonidan kompyuter sinflarida 

olib boriladi. Shu nuqtai nazardan fanlardan bajariladigan barcha amaliy va 

laboratoriya mashg‘ulotlari bevosita kompyuterlar yordamidabajarilib boriladi. 

Kompyuterlar ham boshqa elektr jihozlari kabi elektr toki yordamida ishlaydi. 

Elektr toki esa juda ehtiyotkorlik bilan ish ko‘rishni talab etadi. 

Kompyuter sinflaridagi qurilmalardan noto‘g‘ri foydalanish yong‘in chiqishi, 

baxtsiz hodisalar ro‘y berishi va buning natijasida inson salomatligiga zarar yetishi 

hamda kompyuter jihozlarining buzilishiga olib kelishi mumkin. 

Yuqoridagi noxush holatlarning oldini olish maqsadida xavfsizlik texnikasi 

qoidalari hamda sanitariya-gigiyena talablariga rioya qilishingiz talab etiladi. 

XAVFSIZLIK TEXNIKASI QOIDALARI 

 

 
 

 
 

 

 
 

 

1. O’qituvchining ruxsatisiz o‘zboshimchalik bilan kompyuterlarni ishga 

tushirish; 

2. Kompyuter xonasiga ustki kiyimlarda kirib o‘tirish; 

3. Elektr toki manbalariga va ulanish simlariga tegish; 

4. O‘zboshimchalik bilan kompyuterda sozlash ishlarini olib borish; 

5.Kompyuter ekraniga qo‘l bilan tegish, ishlab turgan kompyuterlarda 

tozalash ishlarini olib borish; 

6. Uzoq vaqt davomida ishlab turgan kompyuterlarni nazoratsiz 

qoldirish; 

7. Kompyuter yonida boshqa elektr va isitish asboblaridan foydalanish; 

8. Kompyuter yonida ovqatlanish, suv ichish; 

9. Tez alangalanuvchi buyumlar va qurilmalarning ichki elementlariga 

salbiy ta’sir etuvchi (kislotali, tarkibida xlor bo‘lgan) moddalarni olib 

kirish; 

10. Klaviatura va kompyuter sich qonchasini ho‘l qo‘llar bilan boshqarish; 

11. Klaviatura va «sichqoncha»dan foyda langanda kuch ishlatish; 

12. Kompyuterni ruxsatsiz o‘chirib, ishni yakunlash ta’qiqlanadi. 
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SANITARIYA-GIGIYENA TALABLARI 

Esda tuting, kompyuterda ishlash davomida kerakli talablarga rioya etmaslik 

inson salomatligiga katta zarar yetkazishi mumkin. Ayniqsa, ko‘z, qon aylanish 

tizimi, bosh miya faoliyati, umurtqa pog‘onasi zaifl ashuvi va turli kasalliklarning 

kelib chiqishiga sababchi bo‘ladi. 

Bularning oldini olish hamda kompyuterda ishlash davomida salomatligingizga 

zarar yetmasligi uchun quyidagi talablarga rioya qili shingiz va ularni esdan 

chiqarmasligingiz kerak: 

 

 

 
 

 
 

1-mashq. Ko‘z mushaklarini 4 soniya qattiq yumib turing, so‘ngra ularni ochib, 6 

soniya uzoqlarga tikilib turing. Bu mashqni 3–4 marta takrorlang. 

2-mashq. Ko‘zlaringizni 4 soniya burun uchiga qarating, so‘ngra 6 soniya uzoqlarga 

tikilib turing. Bu mashqni ham 3–4 marta takrorlang. 

3-mashq. Boshni burmagan holda ko‘zingizni oldin o‘ngga qarating va shu holatni 

biroz saqlab turing, so‘ngra ko‘zingizni to‘g‘riga qaratib, uzoqlarga 6 soniya tikilib turing. 

Xuddi shu mashqlarni ko‘zingizni chapga, pastga va yuqo riga qaratib bajaring. Mashqni 

1–6 hisobda takrorlang. 

4-mashq. Ko‘zni yuqori o‘ng qismidan diagonal bo‘ylab pastki chap qismiga 

o‘tkazing, so‘ngra uzoqlarga 6 soniya tikilib turing. Xuddi shunday usulda faqat ko‘zni 

yuqori chap qismdan pastki o‘ng qismga o‘tkazing va 6 soniya uzoqlarga tikilib turing. Bu 

mashqni 3–5 marta takrorlang.   

 kompyuter stolidan 20 sm uzoqlikda o‘tiring; 

 ko‘zingiz kompyuter ekranidan 50–60 sm uzoqlikda bo‘lsin, 

har 

 20–30 daqiqadan so‘ng ko‘zga dam berib turish va 

kompyuterda ishlash kuniga 180 daqiqadan oshmasligi zarur; 

 yelka va qo‘l tirsagi orasidagi burchak 90–120° ni tashkil 

qilsin; 

 kompyuter oldida o‘tirganingizda gavdangizni tik tuting; 

 oyoq kaftingiz polga to‘laligicha tegib tursin; 

 qo‘l kaftingizni va barmoqlaringizni erkin tuting; 

 qo‘lingizni tanangizga yaqin masofada ushlang; 

 tizza osti burchagi 90° ni tashkil qilsin. 
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1-LABORATORIYA ISHI: 

I. LABORATORIYA MAVZUSI: CORELDRAW DASTURIDA 

TO‘G‘RI VA EGRI CHIZIQLAR CHIZISH. 

II. Laboratoriya ishining maqsadi: Talabalarga CorelDRAW dasturida 

to‘g‘ri va egri chiziqlar chizishning asosiy qadamlarini o‘rgatish. 

III. Laboratoriya ishi uchun kerakli jihozlar: Kompyuter, CorelDraw 

dasturi.  

IV. Laboratoriya ishini o‘tkazish tartibi:  

 
  

2. Dastur imkoniyatlaridan foydalanib, grafik ob’yekt yarating  

 

  

1.   Dasturni ishga tushiring.   

    

  

  

  

  

  

  

  

  

https://hemis.guldu.uz/teacher/subject-topic-info?id=280266&code=356689
https://hemis.guldu.uz/teacher/subject-topic-info?id=280266&code=356689
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3. Tayyor grafik ob’yektni tasvir ko‘rinishida (.jpg formatda) saqlang.  

 
  

 
Variantlar:  

1. Corel Draw dasturi yordamida grafik ob’yekt yarating.  
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2. Corel Draw dasturi yordamida grafik ob’yekt yarating.  

 
3. Corel Draw dasturi yordamida grafik ob’yekt yarating.  

 
  

4. Corel Draw dasturi yordamida grafik ob’yekt yarating.  
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5. Corel Draw dasturi yordamida grafik ob’yekt yarating.  

 
6. Corel Draw dasturi yordamida grafik ob’yekt yarating.  

 
7. Corel Draw dasturi yordamida grafik ob’yekt yarating.  
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8. Corel Draw dasturi yordamida grafik ob’yekt yarating.  

 
9. Corel Draw dasturi yordamida grafik ob’yekt yarating.  

 
  

  

10. Corel Draw dasturi yordamida grafik ob’yekt yarating.  

 



12 

 

11. Corel Draw dasturi yordamida grafik ob’yekt yarating.  

 
 

12. Corel Draw dasturi yordamida grafik ob’yekt yarating.  

 
  

 Corel Draw dasturi yordamida grafik ob’yekt yarating.  
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13. Corel Draw dasturi yordamida grafik ob’yekt yarating.  

  
14. Corel Draw dasturi yordamida grafik ob’yekt yarating.  

  
V. Laboratoriya ishini olingan natija: 

Hurmatli talabalar o‘zgartirilgan shakllarni dizayn qilinganlarizni natijalarini 

ekranda ko‘rsating. 

 

VI. Laboratoriya ishini xulosasi: 

Talabalar yaratilgan shakllarni dizayn qilish vositasidan qanday 

foydalanishadi, o‘zingizning shaxsiy dizaynlaringiz haqida tushuncha bering va 

natijalarni ekranda ko‘rsatishadi. 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022. 



14 

 

2-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: CORELDRAW DASTURIDA 

POLYGON VA BEZE USKUNASI BILAN ISHLASH. 

II. Laboratoriya ishining maqsadi: Talabalarda Polygon instrumenti bilan 

ishlashga o‘rgatish, Talabalarda beze uskunasi bilan ishlashga o‘rgatish.  

III. Laboratoriya uchun kerakli jihozlar: Kompyuter, CorelDraw dasturi.  

IV. Laboratoriya ishini o‘tkazish tartibi:  

1. CorelDraw dasturi polygon instrumenti haqida ma’lumot bering.  

"Polygon Tool" vositasini tanlang. Buning uchun "Toolbox" (Vosita qutisi) 

panelida "Polygon Tool" belgisini toping. Agar "Polygon Tool" belgisi yo‘q bo‘lsa, 

belgilangan vositalarning orasida joylashgan "Rectangle Tool" (To‘g‘ri to‘rtburchak 

qo‘llab-quvvati) belgisini tanlang va u orqali "Polygon Tool" belgisiga kiring. 

 
 

2. CorelDraw dasturi polygon oynasini yuklang. 

3. CorelDraw dasturi turli xildagi poylgon (ko‘pburchak)lar yarating. 

4. CorelDraw dasturi polygon instrumenti yordamida ko‘pburchak uchlari 

ko‘paytiring. 

5. Poylgon instrumenti yordamida yaratilgan ko‘pburchaklarni gradientlar 

va rang to‘ldirish sohasini qisman to‘ldirish instrumentlarini birgalikda ishlatish. 

6. Poylgon instrumenti yordamida yaratilgan obyektlarni ustma-ust hosil 

qiling. 

 

7. CorelDraw dasturida obyektlar yaratilib, Beze uskunasidan foydalanib 

obyektlarni o‘zgartiring.  

 
 

8. CorelDraw dasturida vertikal instrumentlar bandidan maxsus 

effektlardan foydalanib turli xil obyektlar yarating. 

9. CorelDraw dasturida polygon (ko‘pburchaklar) uchlarini o‘zgartiring. 
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V. Laboratoriya ishini olingan natija: 

Polygon uskunasi yordamida hosil qilingan grafik obektlari: 

  
 

O‘quvchilar shakllarni amaliy ravishda o‘zgartirib, dizayn qilib, va natijalarni 

ekranda namoyish etishadi. Ular ishni olib chiqqan beze uskunasi va polygonlarni 

foydalanish orqali tahrirlaganini va dizayn qilinganini ko‘rsatishlari talab qilinadi. 

VI. Laboratoriya ishini xulosasi:  

Xulosa o‘rnida siz yangi shakllarni yaratish va ularni dizayn qilishda beze 

uskunasi va polygonni qanday qo‘llashadi deb ko‘rsatish uchun o‘z fikrlarini 

izohlang. 

1. Polygon va Beze uskunalarining asosiy foydalanish yo‘nalishlari nima? 

2. Polygon uskunasida qanday shakllar yaratish mumkin? 

3. Beze uskunasida chiziqning boshlang‘ich va oxirgi nuqtalari qanday 

belgilanadi? 

4. Bu uskunalar qo‘shimcha funksiyalarga ega bo‘lishi mumkinmi? Agar ha, 

ular nima? 

5. Laboratoriya ishida, qanday shakllarni yaratish va ulardan foydalanish 

mumkin? 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022. 
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3-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: CORELDRAW DASTURIDA MATN 

VA KONTURLAR BILAN ISHLASH. 

II. Laboratoriya ishining maqsadi: Talabalarda CorelDrawda matn va 

konturlar bilan ishlashni o‘rgatish. 

III. Laboratoriya uchun kerakli jihozlar: Kompyuter, CorelDraw dasturi.  

IV. Laboratoriya ishini o‘tkazish tartibi:  

1. Dasturni ochish va interfeys bilan tanishish: 

 CorelDRAW dasturini oching. 

 

2. Matn yozish va xususiyatlarini o‘zgartirish:  

 Matn vositasini tanlang.  

 Ekranga kerakli so‘z yoki gapni yozing.  

 Matn xususiyatlarini o‘zgartirish uchun "Text Properties" panelidan 

foydalaning: shrift, o‘lcham, rang, va boshqa parametrlarni o‘zgartiring. 

3. Matn sozlovchini qo‘llash:  

 Matn vositasini tanlang.  

 "Artistic Text" yoki "Paragraph Text" tanlang.  

 Matnni o‘zgartirish, joylashish, va so‘zlarni qo‘llash uchun "Text" 

panelidan foydalaning. 

4. Konturlar bilan ishlash:  

 Bitta yoki bir nechta ob'ekt (shakl yoki matn)ni tanlang. 

 "Contour" yoki "Outline" vositasini tanlang.  

 Konturlarni o‘lcham va rangini sozlash. 

5. Ob'ektlarni guruhlash va dizayn qilish:  

 Guruhlash: Bitta yoki bir nechta ob'ekt tanlang, ularni guruhlang va 

guruh xususiyatlarini o‘zgartiring.  

 Dizayn qilish: Guruhlangan ob'ektlarni o‘zgartirish, joylashtirish, va 

dizayn qilish uchun qo‘llanish. 
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V. Laboratoriya ishini olingan natija: 

Talabalar o‘zgartirilgan matn va konturlar bilan dizayn qilingan ishlarini 

ekranda ko‘rsatishadi. 

VI. Laboratoriya ishini xulosasi:  

Hurmatli talabalar yangi matnlar va konturlarni dizayn qilishda qanday 

qo‘llanishlardan foydalanganligi, ularning shaxsiy dizaynlari haqida 

tushunchalarini, matnlar va konturlarni dizayn qilishda qo‘shimcha nimalardan 

foydalanilganligi hamda avfzalligi haqida umumiy xulosa yozing 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  

 

 

4-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: CORELDRAW DASTURIDA SHAPE 

USKUNASI BILAN ISHLASH. 

II. Laboratoriya ishining maqsadi: Talabalarda CorelDrawda Shape (figura) 

uskunasi bilan ishlashni o‘rgatish. 

III. Laboratoriya uchun kerakli jihozlar: Kompyuter, CorelDraw dasturi.  

IV. Laboratoriya ishini o‘tkazish tartibi:  

1. Dasturni ochish va interfeysga tanishish: 

 CorelDRAW dasturini oching. 

 Dastur interfeysiga qo‘ng‘iroq qilish va asosiy funksiyalarga 

o‘zgartirishni o‘rganish. 

2. Shape (Figura) vositasini tanlash:  

 Asosiy panel ustida joylashgan "Shape" (figura) vositasini tanlang.  

 "Shape" vositasining o‘z xususiyatlari bilan tanishishing: shakllarni 

yaratish, ularga rang bering, o‘lchamini o‘zgartiring va boshqa parametrlarni 

sozlash. 
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3. Shakllarni yaratish:  

 "Shape" vositasini tanlang.  

 Ekranga ob'ekt (shakl) yaratish uchun qo‘ng‘iroq chizing.  

 Shaklning o‘lchamini va xususiyatlarini o‘zgartiring. 

4. Parametrlarni sozlash:  

 Tanlangan figura uchun rangni belgilang.  

 Kontur (outline) va shaklning xususiyatlari uchun parametrlarni 

sozlang. 

5. Shaklarni tahrirlash va sozlash:  

 Tanlangan shaklni belgilang.  

 Rangini o‘zgartirish, o‘lchamini kamaytirish va boshqa xususiyatlarni 

o‘zgartiring.  

 Shuningdek, shakllarni ko‘chirib, o‘zgartirib va yonaltirish. 

6. Ob'ektlarni guruhlash va dizayn qilish:  

 Guruhlash: Bitta yoki bir nechta ob'ekt tanlang, ularni guruhlang, va 

guruh xususiyatlarini o‘zgartiring.  

 Dizayn qilish: Guruhlangan ob'ektlarni o‘zgartirish, joylashtirish, va 

dizayn qilish uchun qo‘llanish. 

 

V. Laboratoriya ishini olingan natija: 

Hurmatli talabalar o‘zgartirilgan shakllarni dizayn qilinganlarizni natijalarini 

ekranda ko‘rsating. 

 

VI. Laboratoriya ishini xulosasi: 

Talabalar yaratilgan shakllarni dizayn qilishda "Shape" (figura) vositasini 

qanday foydalanishadi, ularning shaxsiy dizaynlari haqida tushunchalari, va 

natijalarni ekranda ko‘rsatishadi. 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  
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5-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: ADOBE PHOTOSHOPDA 

USKUNALAR YORDAMIDA MAXSUS EFFEKTLAR YARATISH. 

 

II. Laboratoriya ishining maqsadi: Talabalarga Adobe Photoshop dasturida 

maxsus effektlar yaratishni o‘rgatish. 

III. Laboratoriya uchun kerakli jihozlar: Kompyuter, Adobe photoshop 

dasturi. 

IV. Laboratoriya ishini o‘tkazish tartibi:  

1. Dasturni ishga tushiring va avtomobil rasmini oling. 

 
2. Endi ana shu background layerimizni nusxalang. (Ctrl+J) 

3. Moshining o‘ng va chap faralariga ketma-ket ravishda lens flare qo‘shing. 

Filter > Render > Lens flare 
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4. Image Readyga o‘ting. Ctrl+Shift+M. Layer1 dagi ko‘zchani olib tashlang. 

Background layerni tanlab, Animation oynasiga tushing va Duplicate 

curren framestugmasini bosing. 

 

 

5. Layer 1 ga o‘ting va undagi ko‘zchani o‘z o‘rniga keltiring va Animation 

oynasiga tushib, Duplicate current frames tugmasini bosing. Layer1 dagi ko‘zchani 

olib tashlang va Background layerni tanlab, Animation oynasiga tushing va 

Duplicate current framestugmasini bosing va layer1dagi ko‘zchani o‘z joyiga 

qo‘ying. Animation oynasiga tushib xuddi quyidagi rasmda ko‘rsatilganidek 

animatsiying davomiyligini belgilang File > Save optimized as.gif formatda saqlang. 

YORUG‘LIK EFFEKTI 

Avvalo yangi oyna oching (File > New yoki Ctrl+N). 

Ushbu qavat (layer) uchun Gradient Overlay va Pattern Overlayni moslang, 

buning uchun Layer > Layer Style > Gradient Overlay bandini tanlang yoki ushbu 

qavat ustiga sichqonching chap tugmasini ikki marta bosing va Gradient Overlay, 

Pattern overlay bandlarini quyidagi rasmda ko‘rsatilgandek moslab chiqing. 
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Endi esa chashkaga quyilgan kofe rasmini ushbu oyningning quyida 

ko‘rsatilgan joyiga joylang. Yoki xohlagan boshqa rasmni joylashtishiringiz ham 

mumkin. 

 

Uskunalar orasidan Ellipse Tool (U)ni tanlang va yangi qavat (layer) ochib, 

quyida ko‘rsatilganday ellips chizing va menyudan Filter > Blur > Guassian Blur 

bandini tanlab Radiusni 30pxga moslab OK tugmasini bosing. 

 

http://psd.grafika.uz/wp-content/uploads/2012/03/Cup-coffee1.png
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Yangi guruh oching, buning uchun menyudan Layer > New > Group bandini 

tanlang, guruhni “Yorug‘lik effekti” deb nomlang va Blend Modeni Color Dodgega 

o‘zgartirib OK tugmasini bosing. Endi boyagi ellips chizilgan va “Blur” effekti 

berilgan qavatni ushbu guruhga joylang. 

 

“Yourg‘lik effekti ” nomli guruh ichida yangi qavat oching va uskunalar 

orasidanBrush Tool (B) ni tanlang va klaviaturingdan F5 tugmasini bosish orqali 

Brush oynasini ochib, quyida ko‘rsatilganday moslab chiqing. 
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2. Endi bir qancha shakllar chizing va ushbu qavat uchun Layer > Layer 

Style > Outer Glow bandini moslang 

 
3. Endi rasmda tutun effekti tasvirlang, buning uchun yangi qavat oching 

(Ctrl+Alt+Shift+N), Blend Modeni Color Dodgega o‘zgartiring. Uskunalar 

orasidanLasso Tool (L)ni tanlang va boshqaruv panelidan Radiusni 40 pixelga 

moslab quyidagicha shakl chizing. Endi Filter > Render > Clouds bandini tanlang 

va chiroyli holatdagi tutun kelib chiqquncha Ctrl+F tugmalarini bosishda davom 

eting.  

 

Uskunalar orasidan Type tool (T) ni tanlab, matn yozing va Layer > Layer 

Style> Outer Glow va quyida ko‘rsatilgan boshqa bandlarni ham moslab chiqing: 
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V. Laboratoriya ishini olingan natija: 

Hurmatli talabalar o‘zgartirilgan shakllarni dizayn qilinganlarizni natijalarini 

ekranda ko‘rsating. 

 

VI. Laboratoriya ishini xulosasi: 

Yaratilgan effektlarni dizayn qilishda qanday qo‘llanishlardan foydalandingiz 

va shaxsiy dizaynlaringiz haqida tushunchalarini va natijalarni xulosa qiling. 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  

 

 

6-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: ADOBE PHOTOSHOPDA VEB-

SAHIFA DIZAYNINI ISHLAB CHIQISH. 

II. Laboratoriya ishining maqsadi: Talabalarda Adobe Photoshop grafik 

muharriri yordamida Web-sahifada grafik ma’lumotlarni aks ettirishni o‘rgatish.  

III. Laboratoriya uchun kerakli jihozlar: Kompyuter, Adobe Photoshop 

dasturi.  

IV. Laboratoriya ishini o‘tkazish tartibi:  

1. Dastlab 700 x 200 pixel o‘lchamda yangi oyna oching. 
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2. Asboblar qatoridan “Rectangular Marquee” asbobini tanlang va 

quyidagicha shakl chizib, qora rangda bo‘yab oling. 

 

3. Edit > Transform > Perspective va quyidagicha moslang: 

 

4. “Add layer mask”buyrug‘ini bajarish uchun quyida ko‘rsatilgan tugmani 

bosing: 

 
5. “Gradeint” asbobini quyidagicha moslang: 

6. Gradient chiziq chizing: 

 

7. “Rounded Rectangle” asbobini tanlang va quyidagicha shakl chizib, 

qora rangda bo‘yab oling. 
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8. “Gradient overlay”ni moslang: 

 

9. “Rectangular Marquee” asbobini tanlab quyidagicha moslang: 

 
10. Tugmacha shaklini chizgan qavat ustiga Ctrl+sichqonching chap 

tugmasini bosing (Ctrl+Click) va quyidagicha shakl chizing. 

 

11. Select > Feather: 

 
12. Yangi qavat oching va bu qavatni oq rangda bo‘yab oling. 

13. “Rounded rectangle” asbobi yordamida quyidagicha shakl chizib oling va 

“make selection” buyrug‘ini tanlang: 

 

14. “Gradient” (G) tanlang va quyidagicha moslang: 
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15. Gradient chiziq chizing: 

16. “Elliptical Marquee” asbobini tanlang va quyidagicha shakl chizing 

hamda ushbu shakl chizilgan qavatimizni #084564 rangda bo‘yab oling. 

 
17. Layer > Layer style:“Rectangular Marquee” asbobini tanlang va 

quyidagicha moslang: 

 
18. Aylana chizilgan qavat ustiga Ctrl+Sichqoncha chap tugmasini bosing 

va quyidagicha shakl chizing: 

19. Yangi qavat oching va bu qavatni #04cae7 rangida bo‘yab oling. 
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20. Yana aylana chizilgan qavatni Ctrl+Sichqoncha chap tugmalarini bosgan 

holatda belgilab oling va quyidagicha shakl chizing: 

21. “Gradient”ni quyidagicha moslang. 

 
22. 5Gradient chiziq chizing. 

23. Tugmacha shaklini hosil qilgan barcha qavatlarni Ctrl+E tugmalarini 

bosib, birlashtiring va bu qavatlarni bir necha marta nusxalang (CTRL+E). 

 

24. Barcha nusxalangan qavatlarni yana birlashtiring va yana bir marta 

nusxalang va pastga olib o‘ting 

 

25. “Add layer mask” buyrug‘ini tanlang: 

 
26. “Gradient”ni quyidagicha moslang: 

27. Gradient chiziq chizing va menyu quyidagicha holatga keladi: 

 

28. “Horizontal Type tool”ni tanlang va matn yozing va menyu ham tayyor: 
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Photoshop dasturida websayt uchun belgichalar tayyorlash 

Adobe Photoshop dasturida juda ham chiroyli va 3D ko‘rinishga ega bo‘lgan 

ajoyib belgichalar tayyorlashni o‘rganing. 

Bu esa, tayyor belgichalar….. 

 

Bunday belgichalar tayyorlash qiyin deb o‘ylaysizmi? Yo‘q juda ham 

oson, ishonmasangiz mashqni kuzatib, bir pasda o‘rganib olishingiz mumkin. 

Demak boshladik…. 

1.500×300 pikselda yangi oyna oching (Ctrl+N). Orqa fonni oq rangda 

bo‘yab oling ( Color pickerdan oq rangni tanlab, Alt+Backspace tugmalarini 

bosing). 

2. Yangi layer (qavat) oching (Ctrl+Alt+Shift+N) va Asboblardan Ellipse 

(Shift+U)ni tanlang va quyida ko‘rsatilganday aylana chizing. 

3. Blending Optionsni moslang, Layer > Layer style >Gradient Overlay: 
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Stroke: 

Endi bizda mana bunday natija hosil bo‘ladi: 

 
Davom eting… 

4. Elliptical Marquee M asbobini oling va quyidagi ko‘rinishda shakl chizing: 

Yangi layer oching (Ctrl+alt+Shift+N) va Gradient G asbobini tanlang va 

ranglarni moslang. 
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Endi chiziq ichidan pastga qarab Gradient chizing: 

5. Tezda aylana shakli chizilgan layer(qavat) ustiga Ctrl+Sichqonching chap 

tugmasini bosing va Ctrl+Shift+I tugmalarini bosing va Delete tugmasini bosish 

orqali aylanadan tashqaridagi gradientni o‘chiring. 

 
Belgilangan joyni o‘z holiga qaytarish uchun Ctrl+D tugmalarini bosing. 

Ellipse asbobini tanlang va color pickerdan#5ebf1a rangni moslab, 

dastlabki aylanadan kichikroq aylana chizing. 

6. Ushbu layer ustiga sichqonching chap tugmasini ikki marta bosing yoki 

Layer 



32 

 

> Layer style > Inner Glow : 

Stroke: 
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Natija: 

Qalay chiqdi, chiroylimi? 

Lekin hali tayyor bo‘lgani yo‘q…. 

7. MenyudanLayer > Rasterize > Shape buyrug‘ini tanlang va Elliptical 

Marquee M asbobini tanlang va quyidagicha shakl chizing va Dodge O asbobini 

tanlab moslang: 

(Brush: 100 px, Range: Shadows Exposure: 20%) 

Ushbu asbob yordamida yashil aylaning pastki qismini ozroq bo‘yab chiqing. 

8. Aylaning yuqori qismini belgilash uchun Ctrl+Shift+I tugmalarini bosing. 

Yana Dodge O asbobini tanlang va aylaning yuqori qismini bo‘yab chiqing. 

 
9. Endi Burn (Shift+U) asbobini tanlang (Brush: 100px, Range : 

Midtones, Exposure: 30%) Aylaning o‘rtasini ozroq bo‘yab chiqing: 
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Belgilangan joyni o‘z holatiga qaytarish uchun Ctrl+D tugmalarini bosing. 

Navbatdagi bosqichga o‘ting. 

10. Ushbu bosqichda belgiching rasmini chizing, buning uchun bizga 

Custom Shape (Shift+U) asbobi kerak bo‘ladi. Demak ushbu asbobni tanlang va 

shakllar ichidan quyidagi shaklni tanlab, oq randga chizing. 

11. Endi ushbu shaklga ozroq soya qo‘shing, demak shakl chizilgan layerni 

tanlab, Layer > Layer style > Drop shadow: 

 
Natija: 

12. Ushbu bosqichni diqqat bilan kuzating, chunki sal xato qilsak natija 

chiqmay qolishi mumkin. 

Layers oynasiga o‘ting va bu yerdan oq belgi chizilgan qavat (layer) va 

background qavat(layer)dan boshqa barcha qavatlarni Ctrl+Sichqonching chap 
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tugmasini bosgan holatda belgilab chiqing ( faqat layerni belgilang, shaklni emas) 

va belgilangan qavatlar(layers) ni birlashtirish uchun Ctrl+E tugmalarini bosing, 

keyin esa oq belgi chizilgan qavatni belgilab yana Ctrl+E tugmasini bosing va bizda 

bor- yo‘g‘I ikki dona qavat(layer) qoladi bulardan biri orqa fon( background) qavat 

va yuqorida bir nechta qavatlar birlashishidan hosil bo‘lgan qavat. 

Demak ushbu qavatni tanlang va Edit > Transform > Distort va moslang: 

 
13. Endi ushbu qavat(layer)ni tanlang va nusxalang(nusxalash uchun Ctrl+J 

tugmalarini bosing). 

Original layerni tanlang va Menyudan Layer > Layer style > Color Overlay: 

 



36 

 

Mana buni natija desa bo‘ladi 

 

Lekin hali ham belgiching tayyor bo‘lgani yoq’. Oxirgi bosqichga o‘ting. 

14. Bu bosqichda belgicha soyasini tasvirlang. 

Background layerga o‘ting va ushbu layer ustidan yangi layer oching 

(Ctrl+Alt+Shift+N) Elliptical Marquee M asbobini tanlab quyidagicha shakl chizing 

va qora rangda bo‘yab oling. (X, D harflarini o‘ynab ranglarni oq va qoraga 

o‘zgartirish mumkin, qora rang tanlangach Alt+Backspace tugmalarini bosing). 

15. Menyudan Select > Deselect yoki Ctrl+D tugmalarini bosing va Filter > 

Blur > Gaussian Blur: 

 
Filter > Blur > Motion Blur: 
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 V. Laboratoriya ishini olingan natija: 

 

Ana shu holatda har xil rangdagi belgichalar tayyorlash mumkin: 

 
Hurmatli talabalar o‘zgartirilgan shakllarni dizayn qilinganlarizni natijalarini 

ekranda ko‘rsating. 

 

VI. Laboratoriya ishini xulosasi: 

Yaratilgan effektlarni dizayn qilishda qanday qo‘llanishlardan foydalandingiz 

va shaxsiy dizaynlaringiz haqida tushunchalarini va natijalarni xulosa qiling. 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.   
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7-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: ADOBE PHOTOSHOP 

MUHARRIRIDA QATLAMLAR BILAN ISHLASH. 

II. Laboratoriya ishining maqsadi: Talabalarga Adobe Photoshop dasturida 

fayllar, ranglar va qatlamlar bilan ishlashni o‘rgatish  

III. Laboratoriya ishi uchun kerakli jihozlar: Kompyuter, Adobe Photoshop.  

IV. Laboratoriya ishini o‘tkazish tartibi:  

Photoshop dasturining ranglar darchasi va maxsus effektlar darchasidan 

foydalanib, quyidagi mashqni bajaring:  Misol. Hammasi oltindan  

Inson yoki biror bir predmetning rasmini oching. So‘ngra uni fondan ajrating 

(Erase Tool yordamida). Quyida namuna:  

 
  

CTRL+U ni bosing va Saturationni chap tomonga oxirgacha suring. Rasm oq-

qora holatiga keladi:  

 
Pastdagi yordamida Curves bo‘limini tanlang va quyidagicha holatga 

keltirishga harakat qiling:  
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CTRL+SHIFT+E ni bosing. So‘ng CTRL+U ni bosing va pastroqda 

Colouriseni belgilab Hue=43, Saturation=48, Lightness=13 larni sozlang:  

 

Filter>Blur>Gaussian Blur ga kirib Radiusni 0,2 pixels qilib OKni bosing.  

  

 
Misol. 2. Bu mashqda asosan ranglar bilan ishlang va ajoyib rangli qalamlar 

tayyorlang….  
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2. Mashqni boshlash uchun 500×300 piksel o‘lchamda, oq fonda yangi oyna 

oching (Ctrl+N).  

 

2. Rectangular Marquee(M) (прямоуголыный шатер) - asbobini 

tanlang va quyidagi rasmda ko‘rsatilgan joyni belgilab, rang kodi #7000a4 ga 

moslab, yangi layer(qavat) oching (Ctrl+Alt+Shift+N) va belgilangan joyni 

bo‘yash uchun menyudan Edit > Fill yoki Alt+Backspace tugmalarini bosing. Bu 

birinchi qalam shakli hisoblanadi.  

 

Shundan so‘ng Rectangular Marquee (M) -  asbobi orqali quyidagi 

joyni belgilang va Dodbe (O) asbobini tanlang (Brush: 50 px, Mode: Highlights, 

Exposure: 50%) va belgilangan joyni bo‘yab chiqing:  
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Endi qalam o‘ng tomonini ham belgilang va Burn (Гореть) (O) asbobi 

(Brush: 50 px, Mode: Shadows, Exposure: 40%) yordamida belgilangan joyni 

bo‘yab chiqing:  

 
Ctrl+D tugmalarini bosing va menyudan Layer >(слой) Layer style 

(стильслой)> Inner Glow ( внутреннее свеченние)ni moslang:  

 
Natija:  

 
Keyingi bosqichga o‘ting…  

3. Ushbu qalam shakli chizilgan qavat(layer)ni nusxalang. Nusxalash uchun 

Layer (слои) > Duplicate Layer (двойной слой) buyrug‘ini tanlang yoki  

Ctrl+J tugmalarini bosing. Yangi hosil bo‘lgan layerni Move (V) (ход) - 

asbobi yordamida o‘ng tomonga o‘tkazing va Image > Adjustments > 

Hue/Saturation (Ctrl+U) Natija:  
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Anashu holatda har bir shaklni nusxalab chiqing va har bir shakl rangini 

yuqorida ko‘rsatilgandayo‘zgartirib chiqing  

 
4. Qalamlar ichidan xohlaganimizni tanlang va Rectangular Marquee (M) 

asbobi yordamida o‘rtadan yuqori qismini belgilang va Delete tugmasini bosing…  

 
Ctrl+D va Polygonal Lasso asbobi yordamida quyidagicha shakl chizing:  

 
Elliptical Marquee (краткий шатер) asbobini tanlang va Alt tugmasini 

bosgan holatda yuqorida chizgan shakl ostini o‘chirib chiqing:  
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Qolgan joylarni ham kesib tashlang va Yangi layer ochib ushbu layerni rang 

kodi #f0d196 da bo‘yab oling:  

 
Yana Polygonal Lasso asbobi yordamida quyidagi joyni belgilang va Dodge 

(O) asbobini tanlab, belgilangan joyni bo‘yab chiqing:  

 
Endi esa o‘ng tomonni belgilang va Burn asbobi yordamida bo‘yab chiqing:  

 
5. Rectangular Marquee (M) asbobi yordamida qalam uchini belgilang va 

Image  

(избражения)> Adjustments (коррекция ) > Hue/Saturation (цветовой 

тон/ насыщенность )yoki Ctrl+U:  
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Natija:  

 
Ctrl+D va Layer > Layer style > Drop Shadow (тень снижения):  

  
Endi oxirgi bosqichga o‘ting…  

6. Horizontal Type (T) asbobini tanlang va matn yozing:  

 
Edit > Transfrom > Rotate 90 CCW  
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Layer > Layer Style> Drop Shadow (тень снижения):  

 
 

V. Laboratoriya ishini olingan natija: 

Dasturni ishga tushiring va natijalarni ekrandada ko‘rsating. 

 
VI. Laboratoriya ishini xulosasi: 

Adobe Photoshop muharririda qatlamlar bilan ishlashda qanday 

instrumentlardan foydalandingiz, o‘zingizning shaxsiy rasm muharrirlari haqida 

tushunchalaringiz va natijalarni ko'rsating hamda tajribalariz haqida izoh bering.  

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  
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8-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: 3DS-MAX DASTURIDA 

OBYEKTLAR USTIDA BAJARILADIGAN OPERATSIYALAR VA 

BUYRUQLAR BILAN ISHLASH. 

II. Laboratoriya ishining maqsadi: Talabalarni 3DS-MAX dasturida 

ob’ektlar ustida bajariladigan operatsiyalar va buyruqlar bilan tanishtirish. 

III. Laboratoriya ishi uchun kerakli jihozlar: Kompyuter, 3DS-MAX 

dasturi.  

IV. Laboratoriya ishini o‘tkazish tartibi:  

1. Dasturni ochish va asosiy interfeys bilan tanishish: 

 3ds Max dasturini oching. 

 Asosiy interfeys bilan tanishing, sahifa orqali barcha vosita va panel 

bilan ishlash uchun majmuaga qarang. 

2. Ob'yektlarni yaratish: 

 Yangi ob'yekt yarating (kube, shish, kub, va hokazo). 

 Ob'yektlarni o'lchamini o'zgartiring. 

3. Ob'yektlarni joylashish va tiklash: 

 Ob'yektlarni joylashtirish va ularni bir-biriga tiklang. 

4. Ob'yektlarni diametri, balandlik, va uzunlik bilan o'zgartirish: 

 Uyga vayron qo'shing (plane, torus, va hokazo). 

 Diametri, balandlik, va uzunlikni o'zgartiring. 

5. Rangi va materiallarni o'zgartirish: 

 Ob'yektlarga rang qo'shish va ularni material bilan o'zgartiring. 

6. Ta'riflar va tekstura qo'shish: 

 Ob'yektlarga ta'rif qo'shish (labels, tags) va ularni tekshiring. 

 Ob'yektlarga tekstura qo'shish va uni o'zgartiring. 

7. Ob'yekt transformatsiyasi: 

 Ob'yekt o'zining harakatlarni o'zgartiring (qaytish, chap-burilish, 

pastga-yo'qish). 

https://hemis.guldu.uz/teacher/subject-topic-info?id=280266&code=356690
https://hemis.guldu.uz/teacher/subject-topic-info?id=280266&code=356690
https://hemis.guldu.uz/teacher/subject-topic-info?id=280266&code=356690
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 Ob'yektlarni doirasida aylantiring. 

8. Buyruqlar va skriptlar: 

 3ds Max dasturida qo'llaniladigan buyruqlar (commands) va skriptlar 

bilan ishlashni o'rganing. 

V. Laboratoriya ishini olingan natija: 

Dasturni ishga tushiring va natijalarni ekrandada ko‘rsating. 

 

VI. Laboratoriya ishini xulosasi: 

3ds Max dasturida ob'yektlar ustida bajariladigan operatsiyalar va buyruqlarni 

o'rganishda qanday instrumentlardan foydalandingiz, o‘zingizning 3D modelingiz 

haqida tushunchalaringiz va natijalarni ko'rsating hamda tajribalariz haqida izoh 

bering  

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  

 

 

9-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: 3DS-MAX DASTURIDA TURLI 

OBYEKTLAR VA JARAYONLARNI MODELLASHTIRISH. 

II. Laboratoriya ishining maqsadi: Talabalarga 3DS-MAX dasturida turli 

ob’ektlar va jarayonlarni modellashtirishni o‘rgatish. 

III. Laboratoriya ishi uchun kerakli jihozlar: Kompyuter, 3DS-MAX 

dasturi.  

IV. Laboratoriya ishini o‘tkazish tartibi:  

1. Dasturni ochish va asosiy interfeys bilan tanishish: 

https://hemis.guldu.uz/teacher/subject-topic-info?id=280266&code=356692
https://hemis.guldu.uz/teacher/subject-topic-info?id=280266&code=356692
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 3ds Max dasturini oching. 

 Asosiy interfeys bilan tanishing, sahifa orqali barcha vosita va panel 

bilan ishlash uchun majmuaga qarang. 

2. Turli ob'yektlarni yaratish: 

 Kub, shish, torus, sphera, va boshqa turdagi ob'yektlarni yarating. 

 Ob'yektlarni o'lchamini o'zgartiring. 

3. Ob'yektlarni joylashish va tiklash: 

 Ob'yektlarni joylashtirish va ularni bir-biriga tiklang. 

4. Jarayonlarni yaratish va ustida ishlash: 

 3ds Max dasturida turli jarayonlarni yarating (helix, spline, polyline, 

va hokazo). 

 Jarayonlar ustida ishlash va ularni o'zgartiring. 

5. Boolean operatsiyalari: 

 Ob'yektlar orasida boolean operatsiyalarni (qo'shish, ayirish, kesish) 

bajaring. 

6. Turli materiallar bilan ishlash: 

 Ob'yektlarga turli materiallar qo'shish va ularni o'zgartiring. 

7. Partikularga qo'shish: 

 Partikularga qo'shish va ularni boshqaring. 

8. Dvizheniya va animatsiya: 

 Ob'yekt va jarayonlarni harakatlantiring. 

 Animatsiya yaratish va uni boshqaring. 

V. Laboratoriya ishini olingan natija: 

 Dasturni ishga tushiring va natijalarni ko‘rsating. 

 

VI. Laboratoriya ishini xulosasi: 

Qilingan 3DS-MAX dasturida turli ob'yektlarni va jarayonlarni 

modellashtirishda qanday qo‘llanishlardan foydalandingiz, o‘zingizning 3D 

modelingiz haqida tushunchalaringiz va natijalarni ko'rsating hamda tajribalariz 

haqida izoh bering 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  
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10-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: 3DS-MAX DASTURIDA 

YORITGICH VA KAMERA O‘RNATISH VA ULAR BILAN ISHLASH. 

II. Laboratoriya ishining maqsadi: Talabalarga 3DS-MAX dasturida 

yoritgichlar va kameralarni o‘rnatishni o‘rgatish.  

III. Laboratoriya ishi uchun kerakli jihozlar: Kompyuter, 3DS-MAX 

dasturi.  

IV. Laboratoriya ishini o‘tkazish tartibi:  

1. Dasturni ochish va asosiy interfeysga tanishish: 

 3ds Max dasturini oching. 

 Asosiy interfeys bilan tanishing, sahifa orqali barcha vosita va panel 

bilan ishlash uchun majmuaga qarang. 

2. Yoritgichni yaratish va o'rnatish: 

 Standart yoritgichlar (omni, spot, direct, va hokazo) yarating. 

 Yoritgichlarni ob'yektlar ustida o‘rnatish va ularni sozlash. 

3. Kamerani yaratish va o'rnatish: 

 Kamera yaratish va uni sozlang. 

 Kamerani ob'yektga joylashtirish va sozlang. 

4. Yoritgich va kamerani boshqarish: 

 Yoritgichlarni yoqish va o'chirish, kuchini o'zgartiring. 

 Kamera parametrlarini sozlash va uni boshqaring. 

5. Yoritgich va kamera animatsiyasi: 

 Yoritgich va kamerani harakatlandiring. 

 Animatsiyalarni yaratish va ularga yo'l qo'ying. 

6. Yoritgich va kamera efektlari: 

 Yoritgich va kamera efektlarini qo‘shish va ularni sozlang. 

7. Dvizheniya va Animatsiya: 

 Ob'yekt va jarayonlarni harakatlandiring. 

 Animatsiya yaratish va uni boshqaring. 

 

V. Laboratoriya ishini olingan natija: 

 Dasturni ishga tushiring va natijalarni ko‘rsating. 

 

VI. Laboratoriya ishini xulosasi: 

Qilingan 3DS-MAX dasturida yoritgich va kamerani o‘rnatishni va ular bilan 

ishlashni qanday qo‘llanishlardan foydalandingiz, o‘zingizning 3D modelingiz 

https://hemis.guldu.uz/teacher/subject-topic-info?id=280266&code=356693
https://hemis.guldu.uz/teacher/subject-topic-info?id=280266&code=356693
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haqida tushunchalaringiz va natijalarni ko'rsating hamda tajribalariz haqida izoh 

bering 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi va 

web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  

 

 

11-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: 3DS-MAX DASTURIDA MESH 

OB’EKTLARI BILAN ISHLASH. 

II. Laboratoriya ishining maqsadi: Talabalarga 3DS-MAX dasturida 

vizuallashtirish va maxsus effektlar o‘rnatishni o‘rgatish.  

III. Laboratoriya ishi uchun kerakli jihozlar: Kompyuter, 3DS-MAX 

dasturi.  

IV. Laboratoriya ishini o‘tkazish tartibi: LCD Monitorni modellashtirish   

LCD monitorni modelini quring. 3ds max ni TOP oynasini ishga tushuring, 

parametrlari bilan BOX ni yarating, huddi. Klaviaturada “S” klavishini bosing. Bu 

klavish faollashtiradi 3ds lar (nuqtalarga bog‟liq, doimiy holatda ekrandagi to‘lqinni 

nuqtalarga bog‟liqligi o‘rnatilgan).  

  
Biz taxrirlanayotgan maydonda o‘zimizni BOX ni yarating. Buning uchun 

undan ajratishni yechmasdan, unga sichqonchaning o‘ng tugmasini bosing, undan 

so‘ng Convert to Editable Poly.   
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Klaviaturada “S” klavishini bosing, bu Angle Snap ni faollashtiradi 

(burchaklarga bog‟liq). «Edge» chegarasi pog‟onasida tahrirni tanlang, Slice Plane 

tugmasini bosing   

(«Edit Geometry» o‘ramida), so‘ng «Left» oyna proeksiyasida, chizmani 900 

ga buring, Tizmani kerakli joyga o‘rnatgach «Slice» tugmasini bosing, «Edit 

Geometry» to‘plamida ham shunday. O‘ramlarni faoliyatini to‘xtatish uchun avval 

«A», so‘ng «S», klavishlarini bosing.  

Tahrirlashni maydonlar darajasidagini tanlang, endigina yaratilgan maydonni 

tanlang, «Extrude» tugmasi yonidagi kvadratni bosing va belgini kiriting, masalan, 

75.   

  
Ajratishni maydondan olmay «Left» oynasiga o‘ting va klaviaturadagi «Select 

and Move» ni faollashtiruvchi «W»tugmasini bosing va biroz o‘ngga o‘tkazing. 

Maydon bilan ishlashni davom ettiring. Yana «Extrude» tugmasi yonidagi kvadratni 

bosing. Paydo bo‘lgan oynada 5 ga teng bo‘lgan bekgini kiriting va «Apply» ni 3 

marta bosing. Sizda rasmda nima bo‘lsa, shu chiqishi kerak.  

 

 
kelishi   

kerak ), qovurg’a darajasiga tahrirlashni faollashtiring va uchta markaziy  

«Window/Crossing Selection»  
  

tugmasini bosing, (bunday ko‘rinishga  
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qovurg‟ani ajrating. Song «Tor» proeksiyasi oynasida o‘ngga o‘tkazing.   

  
«Vertex» cho‘qqilari darajasida tahrirlashni faollashtiring, ikkita markaziy 

nuqtani tanlang va ularni (rasmdagidek) ichkariga suring.  

  
«Window/Crossing Selection» tugmasini faol bo‘lmagan holatga o‘tkazing (u  

bunday  

ko‘rinishda bo‘lishi kerak ).  

«Edge», qovurg‟asi darajasida tahrirlashni tanlang va klaviaturada «Ctrl» 

tugmasini bosib turgan holda (rasmda ko‘rsatilganidek) ichki qovurg‟alarni tanlab, 

ularni «Remove» funksiyasi yordamida o‘chiring. «Remove» funksiyasi 

«DELETE», va «BACKSPACE» tugmalari bilan bir hil emas, uni biror qovurg‟a  

(yoki nuqta) tanlanib, sichqonchani o‘ng tugmasini bosib, ro‘yhatdan  

«Remove» ni tanlab faollashtirish mumkin.   

Maydonlar darajasidagi tahrirlashni tanlang so‘ng, kelib chiqqan maydonni 

tanlab, unga 5 belgili «Extrude» ni qo‘llang. «Left» proyeksiyasi oynasiga o‘tib, 

«Remove» funksiyasi yordamida, paydo bo‘lgan qovurg‟ani o‘chiring. So‘ng 

«Vertex» cho‘qqilari darajasida tahrirlashni tanlang. Qovurg‟alar o‘chirilgachbizga 

mutlaqo kerak bo‘lmagan Z nuqta qoladi. So‘ng ekranni yasashga o‘ting.  

Maydonlar darajasidagi tahrirlashni faollashtiring va biz hozirgina nuqtalarni 

o‘chirgan maydonni ajrating. «Bevel» tugmasi qarshisidagi kichik kvadratni bosing, 
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1-yo‘lda 5 ga teng belgini, 2- yo‘lda 60 ga teng belgini o‘rnating va «OK» tugmasini 

bosing.   

 «Left» proyeksiyasi oynasidagi paydo bo‘lgan maydonni biroz o‘ngga suring 

(X o‘qi bo‘ylab).  

  
Bizning modelimiz hozirgi monitordan ko‘ra ko‘proq televizorga o‘xshaydi. 

Shuning uchun «Front» proyeksiyasi oynasiga o‘tib, maydonni mashtablang. Sizda 

rasmdagidek nimadir paydo bo‘lishi kerak. Masshtablamay o‘zingiz xohlagandek 

qilishingiz ham mumkin.   

 
 Displayimizni yo‘g‟onroq qilishimiz kerak, buning uchun «Extrude» tugmasi 

yonidagi kvadratni bosing va 10 ga teng belgini kiriting. Ajratishni olmay maydonni, 

«Insert» tugmasi yonidagi kichik kvadratni bosing va 10 ga teng belgini kiriting.  
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«Bevel»tugmasi yonidagi kichik kvadratni bosing. 2 ta yo‘lda “-5” belgisini 

kiriting.  

 
 So‘ng ayrim mayday ishlarni najrating. «Left» proyeksiyasi oynasida o‘ng, 

qovurg‟alar darajasidagi tahrirlashni faollashtiring va rasmda ko‘rsatilganidek 

qovurg‟alarni ajrating. «Select and Rotate» tugmasini faollashtiring va displayni 

buring.  

 
Displayni Y o‘qi bo‘ylab biroz tepaga ko‘taring. «Window/Crossing Selection» 

tugmasi haqida unutmang .  

Keling ba‟zi uchlaridan halos bo‟ling. «Perspective» proyeksiyasi oynasiga 

o‟ting va rasmda ko‟rsatilganidek boshlanishdagi qovurg‟ani tanlang. «Chamfer» 
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tugmasi yonidagi kichik kvadratni bosing. Paydo bo‟lgan oynaga 6 belgisini kiriting 

va «OK» ni bosing. Displayning orqa qismidagi qovurg‟a bilan ham huddi shu ishni 

takrorlang, faqat 4 ga teng belgini kiriting. Biz ko‟zlagan maqsadga erishdik monitor 

tayyor.  

 

V. Laboratoriya ishini olingan natija: 

 Dasturni ishga tushiring va natijalarni ko‘rsating. 

 
VI. Laboratoriya ishini xulosasi: 

Qilingan 3DS-MAX dasturida vizuallashtirish va maxsus effektlar o‘rnatishni 

va ular bilan ishlashni qanday qo‘llanishlardan foydalandingiz, o‘zingizning 3D 

modelingiz haqida tushunchalaringiz va natijalarni ko'rsating hamda tajribalariz 

haqida izoh bering 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  

 

 

12-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: 3DS-MAX DASTURIDA 

MATERIALLAR BILAN ISHLASH. 

II. Laboratoriya ishining maqsadi:.  

III. Laboratoriya ishi uchun kerakli jihozlar: Kompyuter, 3DS-MAX 

dasturi.  
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IV. Laboratoriya ishini o‘tkazish tartibi: 

1. Dasturni ochish va asosiy interfeysga tanishish: 

 3ds Max dasturini oching. 

 Asosiy interfeys bilan tanishing, sahifa orqali barcha vosita va panel 

bilan ishlash uchun majmuaga qarang. 

2. Materiallar bilan tanishish: 

 Standart materiallar paneli va mental ray materiallar paneli bilan 

tanishing. 

 Ob'yektga material qo‘shing. 

3. Materiallarni o'zgartirish: 

 Diffuse, specular, reflection va boshqa materiallarni o'zgartiring. 

 UV mapping va texture bilan ishlang. 

4. Procedural materiallar: 

 Procedural materiallarni qo'shish va ularni o'zgartiring. 

 Noise, gradient, cellular va boshqa procedural materiallar bilan 

tanishing. 

5. Multi/Sub-object material: 

 Multi/Sub-Object materialni qo'shish va unda o'zgartirishlar kiriting. 

 Ob'yektning har bir qismini alohida material bilan o'zgartiring. 

6. Gizlish materiallar: 

 Gizlish materiallarni qo'shish va ularni ob'yektlarga ulashing. 

 Ob'yektlarni gizlish materiallar bilan o'zgartiring. 

7. Rasm materiallari: 

 Rasm materiallarini qo'shish va ularni o'zgartiring. 

 Rasm texturelarni o'zgartirish va UVW mapni sozlang. 

8. Bump va normal mapping: 

 Bump mapping va normal mapping orqali ob'yektlarga texturni 

qo'shing. 

 Materiallarga shininess va specular level kiriting. 
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9. Raytrace material va mental ray: 

 Raytrace materialni qo'shish va sozlang. 

 Mental Ray render uchun materiallar tuzing. 

 

V. Laboratoriya ishini olingan natija: 

 Dasturni ishga tushiring va natijalarni ko‘rsating. 

 

VI. Laboratoriya ishini xulosasi: 

Qilingan 3DS-MAX dasturida materiallar bilan ishlashda qanday 

qo‘llanishlardan foydalandingiz, o‘zingizning 3D modelingiz haqida 

tushunchalaringiz va natijalarni ko'rsating hamda tajribalariz haqida izoh bering 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  

 

 

13-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: 3DS-MAX DASTURIDA TEKSTURA 

BILAN ISHLASH. 

II. Laboratoriya ishining maqsadi: Talabalarga 3DS-MAX dasturida 

texturada ishlashni o’rgatish. 

III. Laboratoriya ishi uchun kerakli jihozlar: Kompyuter, 3DS-MAX 

dasturi, amaliy     dasturlar, standart dasturlar, internet brauzerlar va x.k. 

IV. Laboratoriya ishini o‘tkazish tartibi: 
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1. Dasturni ochish va asosiy interfeysga tanishish: 

 3ds Max dasturini oching. 

 Asosiy interfeysga tanishing, sahifa orqali barcha vositalar va panel 

bilan ishlash uchun tuzilmang. 

2. Ob'yektga material qo'shish: 

 Ob'yektga material qo‘shish va uni o'zgartirish. 

 Materiallarni standart va mental ray materiallar panelidan tanlash. 

3. Diffuse va texture bilan ishlash: 

 Ob'yektlarga rang qo‘shtirish va uni o'zgartirish. 

 Texture (rasm) qo'shish va ob'yektga ulashish. 

4. UV mapping: 

 UV mappingni o'rganish va tekshirish. 

 UVW map sozlash va teksturalarni joylashtirish. 

5. Procedural texturelar: 

 Procedural texturelarni qo'shish va ularni o'zgartirish. 

 Noise, gradient, cellular va boshqa procedural texturelarni tanlash. 

6. Bitmap texturelar: 

 Rasm (bitmap) texturelarni qo'shish va ularni o'zgartirish. 

 Textureni ob'yektga joylashtirish va uni o'zgartirish. 

7. Bump va normal mapping: 

 Bump va normal mapping orqali ob'yektlarga relief (qo'shinqi 

texturni) qo'shish. 

 Bump va normal texturelarni o'zgartirish va ularga parametrlar 

qo‘shish. 

8. Reflective va refractive materiallar: 

 Reflective va refractive materiallarni o'rganish. 

 Materiallarga shininess va transparency qo‘shish. 

9. Masking va blending: 
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 Texturelarni masking (maska bilan qoplash) va blending 

(aralashtirish) qilish. 

 Blend materialni o'rganish va uni o'zgartirish. 

 

V. Laboratoriya ishini olingan natija: 

 Dasturni ishga tushiring va natijalarni ko‘rsating. 

 

VI. Laboratoriya ishini xulosasi: 

Qilingan 3DS-MAX dasturida tekstura bilan ishlashda qanday qo‘llanishlardan 

foydalandingiz, o‘zingizning 3D modelingiz haqida tushunchalaringiz va natijalarni 

ko'rsating hamda tajribalariz haqida izoh bering 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  

 

 

14-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: HTML TILIDA TEGLAR 

YORDAMIDA ODDIY VEB SAHIFALAR YARATISH. 

II. Laboratoriya ishining maqsadi: Talabalarga HTML tilida teglar 

yordamida oddiy veb sahifalar yaratishni o'rganishni o‘rgatish.  

III. Laboratoriya ishi uchun kerakli jihozlar: Matn muharriri (Notepad++, 

Visual Studio Code yoki boshqa muharrir), Veb brauzer (Chrome, Firefox, Safari 

yoki boshqa) 
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IV. Laboratoriya ishini o‘tkazish tartibi: 

1. Mundarija tuzish: 

 Proyektingiz uchun yangi papka tuzing. 

 Muharrir (matn muharriri yoki Visual Studio Code) orqali yangi 

faylni oching. 

2. HTML qo'llanishlar: 

 HTML asosiy qo‘llanishlari: <!DOCTYPE html>, <html>, <head>, 

<title>, va <body>. 

3. Matn va sarlavhalar: 

 Sarlavha (<h1>, <h2>, ..., <h6>) va matn (<p>) teglarini ishlatish. 

 Matn elementlarini bold (qalin), italic (yorqin), underline (past), va 

strike-through (uchrashgan) qilish. 

4. Royxatlar: 

 Tartiblangan va tartiblanmagan ro'yxatlar (<ul>, <ol>, <li>) ishlatish. 

5. Rasmlar: 

 Rasm (<img>) qo'shish va uni sozlash. 

 Rasmlarga alternative matn (alt attributi) qo'shish. 

6. Havolalar: 

 Matnga havola (<a>) qo'shish va uni sozlash. 

 Havolalarga qo‘llanish (external va internal) qo'shish. 

7. Formalar: 

 Oddiy kontak formani (<form>, <input>, <textarea>) yaratish. 

8. HTML validatsiyasi: 

 HTML validator orqali kodni tekshirish. 

 

V. Laboratoriya ishini olingan natija: 

 Dasturni ishga tushiring va natijalarni brauzerda ko‘rsating. 

 Qo‘llanilgan HTML va CSS kodlari orqali sahifani tahrirlashingizni 

ko‘rsating. 
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VI. Laboratoriya ishini xulosasi: 

Tuzilgan HTML sahifasini dizayn qilishda qanday qo‘llanishlardan 

foydalandingiz, o‘zingizning shaxsiy dizaynlaringiz haqida tushunchalariz va 

tajribalariz haqida izoh bering 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  

 

 

15-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: HTML TILIDA ANIMATSIYA VA 

MULTIMEDIA BILAN ISHLASH. 

II. Laboratoriya ishining maqsadi: Talabalarga HTML tilida teglar 

yordamida oddiy veb sahifalar yaratishni o'rganishni o‘rgatish.  

III. Laboratoriya ishi uchun kerakli jihozlar: Matn muharriri (Notepad++, 

Visual Studio Code yoki boshqa muharrir), Veb brauzer (Chrome, Firefox, Safari 

yoki boshqa) 

IV. Laboratoriya ishini o‘tkazish tartibi: 

1-Topshiriq. HTML da matn qismiga rang bering va saxifaga och ko‘k 

rangda yoki rasmli fon bering. 

HTML faylni yaratish uchun quyidagilarni bajaring: 

1. Web saxifani saqlash uchun ixtiyoriy diskka ismingiz nomi bilan papka 

yarating 
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2. Standart dasturlar ichidan Bloknotni oching. 

 

3. Quyidagi manni html kodlash tilida kiriting: 

 

4. Bajarilgan ishni “Сахранит как” dan index.html deb saqlang: 
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1. Animatsiya elementlari: 

 <marquee> elementi orqali matn animatsiyasini qo'shing. 

 CSS3 va <keyframes> orqali matn elementlarini animatsiya qiling. 

2. Audio va video: 

 <audio> va <video> elementlari orqali audiolarni va videolarni 

qo'shing. 

 Audioga mazmun (controls, autoplay, loop) qo‘shing. 

3. YouTube video integratsiyasi: 

 YouTube videoni sahifaga joylash va uni boshqaring (autoplay, 

controls). 

4. SVG grafika: 

 SVG (Scalable Vector Graphics) elementlari orqali vektoriy grafika 

yaratish va sahifaga qo'shing. 

5. Canvas va WebGL: 

 <canvas> va WebGL orqali veb sahifada grafika yarating. 

6. HTML media API: 

 JavaScript orqali HTML media elementlarini boshqaring. 

7. HTML animatsiya va CSS transitions: 
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 HTML va CSS orqali oddiy animatsiyalarni yarating. 

V. Laboratoriya ishini olingan natija: 

 Dasturni ishga tushiring va natijalarni brauzerda ko‘rsating. 

 

VI. Laboratoriya ishini xulosasi: 

HTML tilida animatsiya va multimedia bilan ishlashda qanday qo‘llanishlardan 

foydalandingiz, o‘zingizning shaxsiy dizaynlaringiz haqida tushunchalariz va 

tajribalariz haqida izoh bering 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  

 

 

16-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: DREAMWEAVER DASTURIDA 

GIPERMATNLI WEB-SAHIFA YARATISH. 

II. Laboratoriya ishining maqsadi: Talabalarga Dreamweaver dasturini 

o‘rnatish, oyna qismlari bilan tanishish va web-saxifa yaratish texnologiyasini 

o‘rgatish.  

III. Laboratoriya ishi uchun kerakli jihozlar: Kompyuter, ma’ruza matnlari, 

videproektor, Windows XP operatsion tizimi, Macromedia Dreamweaver 8 amaliy 

dastur, Internet Explorer internet brauzer dasturi va x.k. 

IV. Laboratoriya ishini o‘tkazish tartibi:  

Dreamweaver dasturi HTML va CSS kodi yozishga yordam beruvchi bir 

muharrir boʻlib, gipermatnli veb-sahifalar yaratishda oʻzgaruvchilik va qulaylik 
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kiritadi. Quyidagi qadamlar orqali Dreamweaver dasturida gipermatnli veb-sahifa 

yarating: 

 

Dreamweaver dasturini oching va yangi sahifa yaratish uchun "File" (Fayl) 

menyusidan "New" (Yangi) ni tanlang. Alternativ ravishda, klaviatura 

chapaningizda Ctrl (Windows) yoki Command (Mac) tugmasini bosib, N klavishini 

bosing. 

"New Document" (Yangi hujjat) dialog oynasida, "Blank Page" (Boʻsh sahifa) 

ni tanlang va "HTML"ni tanlang. Soʻng "Create" (Yaratish) tugmasini bosing. 

 

Yangi hujjatning muharrir oynasida HTML taglari bilan boshlash uchun asosiy 

taglarni kiritishingiz mumkin. Masalan: 
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<!DOCTYPE html> 

<html lang="en"> 

<head> 

  <meta charset="UTF-8"> 

  <title>My First Website</title> 

</head> 

<body> 

  <h1>Welcome to My Website</h1> 

  <p>This is a sample paragraph.</p> 

</body> 

</html> 

Tekstni ajratish va koʻrinishni oʻzgartirish uchun CSS usullaridan 

foydalanishingiz mumkin. CSS kodlarini <style> tagi ichida yozishingiz mumkin. 

Masalan: 

<!DOCTYPE html> 

<html lang="en"> 

<head> 

  <meta charset="UTF-8"> 

  <title>My First Website</title> 

  <style> 

    h1 { 
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      color: blue; 

      font-size: 24px; 

    } 

    p { color: green } 

  </style> 

</head> 

<body> 

  <h1>Welcome to My Website</h1> 

  <p>This is a sample paragraph.</p> 

</body> 

</html> 

 

Sahifangizni gipermatnli qilish uchun linklarni qoʻshishingiz mumkin. <a> 

(anchor) tagi orqali linklarni sahifaga qoʻshishingiz mumkin. Masalan: 

<p>Visit my <a href="https://www.example.com">website</a> for more 

information.</p> 

Sahifangizning tasvirli boʻlishi uchun rasmlarni <img> tagi orqali sahifaga 

joylashtirishingiz mumkin. Masalan: 

<img src="image.jpg" alt="My Image"> 
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Sahifangizni saqlab, brauzeringizda tekshiring. Dreamweaver dasturida "File" 

(Fayl) menyusidan "Save" (Saqlash) ni tanlang va fayl nomini va joylashuvini 

tanlang. 

V. Laboratoriya ishini olingan natija: 

 Dasturni ishga tushiring va natijalarni brauzerda ko‘rsating. 

 

 

 

VI. Laboratoriya ishini xulosasi: 

Adobe Dreamweaver dasturida gipermatnli veb sahifa yaratishda qanday 

qo‘llanishlardan foydalandingiz, o‘zingizning shaxsiy dizaynlaringiz haqida 

tushunchalariz va tajribalariz haqida izoh bering 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  
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17-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: DREAMWEAVER DASTURIDA 

FORMALAR VA FREYMLAR. 

II. Laboratoriya ishining maqsadi: Talabalarga Dreamwyeaver dasturida 

formalardan foyladalanish va freymlar bilan ishlashni o’rgatish. 

III. Laboratoriya ishi uchun kerakli jihozlar: Adobe Dreamweaver dasturi 

o'rnatilgan bo'lishi, Veb brauzer (Chrome, Firefox, Safari yoki boshqa). 

IV. Laboratoriya ishini o‘tkazish tartibi:  

Dreamweaver dasturi formalar va freymlar bilan ishlashda qulaylik va 

oʻzgaruvchilik kiritishga yordam beradi. U HTML va CSS kodi yozishni 

osonlashtiradi va foydalanuvchi bilan interaktivlikni yaratish imkonini beradi. 

1. Dreamweaver dasturini ochish: 

 Adobe Dreamweaver dasturini oching. 

2. Yangi sahifa yaratish: 

 Yangi HTML sahifa yaratish va uni asosiy HTML taglari bilan 

to'ldiring. 

3. Forma yaratish: 

 Oddiy kontakt forma yarating (<form>, <input>, <textarea>). 

4. Forma elementlari: 

 Forma elementlarini (matn kiriting, tugma, tanlov) qo‘shing. 

5. Buyurtma formasi: 

 Buyurtma formasini yaratish va unga elementlar qo‘shing. 

6. Forma validatsiyasi: 

 JavaScript orqali forma validatsiyasini qo‘shing. 

7. Freymlarni yaratish: 

 Ijtimoiy tarmoqdan olingan freymlarni (<iframe>) qo‘shtiring. 

8. CSS qo‘llash: 

 CSS orqali stil berish va veb sahifani chiroyli ko'rinishga olib kelish. 
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V. Laboratoriya ishini olingan natija: 

 Dasturni ishga tushiring va natijalarni brauzerda ko‘rsating. 

 

VI. Laboratoriya ishini xulosasi: 

Adobe Dreamweaver dasturida formalarni va freymlarni yaratishda qanday 

qo‘llanishlardan foydalandingiz, o‘zingizning shaxsiy dizaynlaringiz haqida 

tushunchalariz va tajribalariz haqida izoh bering 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  

 

 

18-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: DREAMWEAVER DASTURIDA 

WEB-UZEL YARATISH. 

II. Laboratoriya ishining maqsadi: Talabalarga Dreamweaver dasturida 

web-uzel yaratish texnologiyasini o’rgatish.  

III. Laboratoriya ishi uchun kerakli jihozlar: Adobe Dreamweaver dasturi 

o'rnatilgan bo'lishi, Veb brauzer (Chrome, Firefox, Safari yoki boshqa). 

IV. Laboratoriya ishini o‘tkazish tartibi:  

Dreamweaver dasturi, web-uzellarni yaratishda qulaylik va oʻzgaruvchilik 

kiritishga yordam beradi. U HTML, CSS va JavaScript kodi yozishni osonlashtiradi 

va vizual ravishda tahrirlash imkonini beradi. 

1. Dreamweaver dasturini ochish: 

 Adobe Dreamweaver dasturini oching. 

2. Yangi sahifa yaratish: 
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 Yangi HTML sahifa yaratish va uni asosiy HTML taglari bilan 

to'ldiring. 

3. Matn va rasm uzeli: 

 Matn (<p>) va rasm (<img>) uzelini yarating. 

4. Matn uzeli hyperlink qilish: 

 Matn uzeliga (<a>) havola (link) qo‘shing. 

5. Rasm uzeli hyperlink qilish: 

 Rasm uzeliga (<a>) havola (link) qo‘shtiring. 

6. Matn va rasm uzeli qo‘shish: 

 Matn va rasm uzelini bir-biriga bog'langan sahifa yarating. 

7. Rasm uzeli va foydalanuvchi uzlari: 

 Rasm uzelini va foydalanuvchi uzelini (<mailto>) yarating. 

8. CSS qo‘llash: 

 CSS orqali stil berish va veb sahifani chiroyli ko'rinishga olib kelish. 

9. Menu uzelini yaratish: 

 Oddiy menu uzelini (<ul>, <li>) yarating. 

 

 Web-uzel yaratish jarayoni quyidagi tartibda amalga oshiriladi 

Dreamweaver dasturida: 

1. Dreamweaver dasturini oching va yangi sahifa yaratish uchun "File" (Fayl) 

menyusidan "New" (Yangi) ni tanlang yoki klaviatura chapaningizda Ctrl 

(Windows) yoki Command (Mac) tugmasini bosib N klavishini bosing. 

2. "New Document" (Yangi hujjat) dialog oynasida, "Blank Page" (Bo'sh 

sahifa) ni tanlang va "HTML"ni tanlang. Soʻng "Create" (Yaratish) tugmasini 

bosing. 

3. Muharrir oynasida HTML taglari bilan boshlash uchun asosiy taglarni 

kiritishingiz mumkin. HTML kodlarini muharrir oynasida yozib, dastur tomonidan 

sintaksis tekshiruvi amalga oshiring. 

4. Uzelsingiz, yangi web-uzelni qoʻshish uchun "Insert" (Joylashtirish) 

menyusidan kerakli "Button" (Tugma), "Image" (Rasm), "Text" (Matn) elementni 

tanlang. 

5. Web-uzelga CSS stilini qoʻshishingiz mumkin. CSS usullarini muharrir 

oynasida yozib, "CSS Designer" paneli orqali stilni elementlarga taqsimlang. 

6. Web-uzelga interaktivlik qoʻshish uchun JavaScript kodini qoʻshing. 

JavaScript kodini muharrir oynasida yozib, web-uzelga foydalanuvchining 

interaktsiyasini yarating. 

7. Sahifangizni saqlab, brauzerda tekshiring. "File" (Fayl) menyusidan "Save" 

(Saqlash) ni tanlang va fayl nomi va joylashuvi tanlang. 
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Dreamweaver dasturi web-uzel yaratish uchun moslashtirilgan bir vosita 

hisoblanadi. U HTML, CSS va JavaScript muharririning oʻzgaruvchilik va vizual 

tahrirlash imkonini beradi va web-uzellarni osonlik bilan yaratishga yordam beradi. 

 

V. Laboratoriya ishini olingan natija: 

 Dasturni ishga tushiring va natijalarni brauzerda ko‘rsating. 

 

VI. Laboratoriya ishini xulosasi: 

Adobe Dreamweaver dasturida web-uzel (link) yaratishda qanday 

qo‘llanishlardan foydalandingiz, o‘zingizning shaxsiy dizaynlaringiz haqida 

tushunchalariz va tajribalariz haqida izoh bering 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  

 

 

19-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: CSS DA BLOKLAR UCHUN TURLI 

DIZAYN ELEMENTLARINI O‘RNATISH. 

II. Laboratoriya ishining maqsadi: Talabalarga CSS da bloklar bilan ishlash 

va ularga turli dizayn berishni o’rgatish. 

III. Laboratoriya ishi uchun kerakli jihozlar: Matn muharriri (Notepad++, 

Visual Studio Code yoki boshqa), Veb brauzer (Chrome, Firefox, Safari yoki 

boshqa). 

IV. Laboratoriya ishini o‘tkazish tartibi:  

1. HTML faylini yaratish: 

 HTML faylini yaratish va asosiy HTML taglarini qo'shish. 

2. Bloklarni tuzish: 

 Turli xil bloklarni (<div>, <section>, va hokazo) tuzish. 

3. Background va ranglar: 

 Bloklarga fono (background) qo'shish va ularni ranglar bilan 

o'rnatish. 
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4. Yorliq (Box) model: 

 Box modelni tushunish va uni o'zgartirish (margin, padding, border). 

5. Shriftlar va matn o'zgartirish: 

 Bloklarga shrift (font-family), o'lcham (font-size), va rang (color) 

qo'shish. 

6. Text transform va decoration: 

 Matn transformatsiyasini (text-transform) va bezovta (text-

decoration) qo'shish. 

7. Border va radius: 

 Bloklarga chiziq (border) va kengaytma (border-radius) qo'shish. 

8. Box shadow va transition: 

 Bloklarga box shadow (box-shadow) va o'zgaruvchanlik (transition) 

qo'shish. 

9. Grid va flexbox: 

 Grid va flexboxni ishlatib bloklarni joylashtiring. 

 

CSS (Cascading Style Sheets) orqali bloklar uchun turli dizayn elementlarini 

o'rnatish imkoniyatiga egasiz. CSS, veb-saytlar va veb-uzellarni stil berish uchun 

ishlatiladi. Quyidagi turli dizayn elementlari bilan bloklarni o'rnatish uchun 

qoʻllaniladigan usullarni koʻrib chiqing: 

1. Margins (boʻshligi): "margin" xususiyati orqali blokning oʻrnini belgilang. 

Misol uchun, margin: 10px; blokning barcha tomonlari orasiga 10 piksel boʻshlik 

qoʻyadi. 

2. Paddings (chaplash): "padding" xususiyati orqali blokning ichki boʻshligini 

belgilang. Misol uchun, padding: 20px; blokning ichki tomonlariga 20 piksel 

boʻshlik qoʻyadi. 

3. Borders (chechaklar): "border" xususiyati orqali blokning chechaklarini 

belgilang. Misol uchun, border: 1px solid black; 1 piksel keng chechakli qora chekka 

qoʻyadi. 

4. Backgrounds (fon): "background" xususiyati orqali blokning foni belgilang. 

Misol uchun, background: #f1f1f1; blokning fonini pastel oq rangga oʻrnatadi. 

5. Width and Height (en va balandlik): "width" va "height" xususiyatlari orqali 

blokning eni va balandligini belgilang. Misol uchun, width: 200px; height: 150px; 

blokning eni 200 piksel va balandligi 150 piksel boʻladi. 

6. Display (koʻrsatish): "display" xususiyati orqali blokning koʻrsatish uslini 

tanlang. Misol uchun, display: inline; blokni qatorning ichida joylashtiring. 

7. Positioning (joylashtirish): "position" xususiyati orqali blokning 

joylashuvini belgilang. Misol uchun, position: absolute; top: 50px; left: 100px; 
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blokni absolut pozitsiyada joylashtiradi, yuqorisida 50 piksel va chapida 100 

piksellik masofada. 

8. Box Shadows (quti soʻnggi): "box-shadow" xususiyati orqali blokning quti 

soʻnggisini belgilang. Misol uchun, box-shadow: 2px 2px 5px rgba(0, 0, 0, 0.3); 

blokning quti soʻnggisini 2 piksel kengligida va 5 piksel oʻtkazib yuboradi. 

Bu faqat bir nechta CSS xususiyatlardan foydalanishning misollaridir. CSSning 

qoʻllanishi koʻp va turli dizayn elementlari va xususiyatlari mavjud. Bloklarni 

oʻrnatish uchun kerakli dizayn elementlarini tanlash va ularga mos CSS 

xususiyatlarini belgilash orqali oʻzgartirish imkoniyatiga egasiz. 

V. Laboratoriya ishini olingan natija: 

 Dasturni ishga tushiring va natijalarni brauzerda ko‘rsating. 

 

VI. Laboratoriya ishini xulosasi: 

CSS qo'llanish bilan bloklarni qanday qo‘llanishlardan foydalandingiz, 

o‘zingizning shaxsiy dizaynlaringiz haqida tushunchalariz va tajribalariz haqida 

izoh bering 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  

 

 

20-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: CSS DA JADVAL VA 

FORMALARGA STILLAR BERISH. 

II. Laboratoriya ishining maqsadi: Talabalarga CSS (Cascading Style 

Sheets) qo'llanib, jadvallarga va formalarga (tables va forms) dizayn elementlarini 

o’rgatish 

III. Laboratoriya ishi uchun kerakli jihozlar: Matn muharriri (Notepad++, 

Visual Studio Code yoki boshqa), Veb brauzer (Chrome, Firefox, Safari yoki 

boshqa). 

IV. Laboratoriya ishini o‘tkazish tartibi:  

1. HTML faylini yaratish: 
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 HTML faylini yaratish va asosiy HTML taglarini qo'shing. 

2. Jadvalni yaratish: 

 HTML-da <table>, <tr>, va <td> taglaridan foydalanib jadval 

yarating. 

3. Jadval elementlarini stil berish: 

 Jadvalning qatorlarini (<tr>), ustunlarini (<th>), va cellalarni (<td>) 

stil bering. 

4. Jadvalga background va border qo'shish: 

 Jadvalga fono (background) va chiziq (border) qo'shing. 

5. Formalarni yaratish: 

 Oddiy forma elementlarini (<form>, <input>, va hokazo) qo'shing. 

6. Formalarga stil berish: 

 Formalarni stil bering (o'lcham, rang, border, va hokazo). 

7. Placeholder qo'shish: 

 Formalarga placeholder qo'shing (::placeholder pseudoelementi 

orqali). 

8. Shakllarni ornatish: 

 Shakllarni (rectangle, circle, round, va hokazo) o‘rnating. 

9. Flexbox va grid: 

 Flexbox va gridni ishlatib jadvallarni va formalarni joylashtiring. 

 

CSS orqali jadval va formalarga stillar berish oson va samarali bo'ladi. 

Quyidagi CSS atributlari orqali jadval va formalarni o'zgartirishingiz mumkin: 

1. Jadval (table) elementlari uchun stillar: 

  - `border`: Jadvalning chegara stilini belgilash uchun ishlatiladi. 

  - `padding`: Jadvalning ichki joyini belgilash uchun ishlatiladi. 

  - `background`: Jadvalning fon rangini belgilash uchun ishlatiladi. 

  - `text-align`: Matn elementlarining o'rtasiga ko'rsatiladigan yozuvning 

o'rnatilishini belgilash uchun ishlatiladi. 

  - `font-family`, `font-size`: Jadvalning matn elementlarining shrift va 

o'lchamini belgilash uchun ishlatiladi. 

  - `color`: Jadvalning matn elementlarining rangini belgilash uchun ishlatiladi. 

  Misol uchun: 

  table { 

   border: 1px solid #ccc; 

   padding: 10px; 

   background-color: #f1f1f1; 

   text-align: center; 
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  } 

  table th { 

   background-color: #ddd; 

   font-weight: bold; 

  } 

  table td { 

   font-family: Arial, sans-serif; 

   font-size: 14px; 

   color: #333; 

  } 

2. Formalar (form) uchun stillar: 

  - `margin`: Formalarning orqa marginini belgilash uchun ishlatiladi. 

  - `padding`: Formalarning ichki joyini belgilash uchun ishlatiladi. 

  - `background`: Formalarning fon rangini belgilash uchun ishlatiladi. 

  - `text-align`: Matn elementlarining o'rtasiga ko'rsatiladigan yozuvning 

o'rnatilishini belgilash uchun ishlatiladi. 

  - `font-family`, `font-size`: Formalarning matn elementlarining shrift va 

o'lchamini belgilash uchun ishlatiladi. 

  - `color`: Formalarning matn elementlarining rangini belgilash uchun 

ishlatiladi. 

  Misol uchun: 

  form { 

   margin: 20px; 

   padding: 10px; 

   background-color: #f1f1f1; 

   text-align: center; 

  } 

  form label { 

   font-weight: bold; 

  } 

  form input[type="text"], form textarea { 

   width: 200px; 

   padding: 5px; 

   font-family: Arial, sans-serif; 

   font-size: 14px; 

   color: #333; 

  } 

 

  form button { 
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   background-color: #ddd; 

   padding: 5px 10px; 

   border: none; 

   cursor: pointer; 

  } 

V. Laboratoriya ishini olingan natija: 

 Dasturni ishga tushiring va natijalarni brauzerda ko‘rsating. 

 

VI. Laboratoriya ishini xulosasi: 

CSS qo'llanib, jadvallarga va formalarga qanday qo‘llanishlardan 

foydalandingiz, o‘zingizning shaxsiy dizaynlaringiz haqida tushunchalariz va 

tajribalariz haqida izoh bering 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  

 

 

21-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: CSS DA RASMLAR VA 

ANIMATSIYALAR UCHUN STILLAR BERISH. 

II. Laboratoriya ishining maqsadi: Talabalarga jadval va formalarga still 

berish va ularda ishlashni o’rgatish 

III. Laboratoriya ishi uchun kerakli jihozlar: Matn muharriri (Notepad++, 

Visual Studio Code yoki boshqa), Rasm fayllari (PNG, JPG, SVG yoki boshqa), 

Veb brauzer (Chrome, Firefox, Safari yoki boshqa) 

IV. Laboratoriya ishini o‘tkazish tartibi:  

1. HTML faylini yaratish: 

 HTML faylini yaratish va asosiy HTML taglarini qo'shing. 

2. Rasmlarni qo'shish: 

 Rasmlarni (<img>) qo'shing va ularni o'zgartiring (width, height). 

3. Rasmlarga stil berish: 
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 Rasmlarga fono (background), chiziq (border), va har xil effektlarni 

qo'shing. 

4. Animatsiyalar uchun keyframes: 

 CSS keyframes va animatsiyalar yarating. 

5. Transition va transform: 

 Transition (transition) va transform (transform) orqali animatsiyalar 

qo'shing. 

6. Hover efektlari: 

 Rasmlarga hover holatida (:hover) efektlar qo'shing. 

7. Rasm galereyasi: 

 Rasm galereyasi yarating va rasmlarni aylantirish (rotate) 

animatsiyasi. 

8. SVG rasm uchun stil berish: 

 Scalable Vector Graphics (SVG) rasm uchun stil bering. 

9. SVG animatsiyasi: 

 SVG animatsiyalarni yarating (SMIL yoki CSS). 

 

V. Laboratoriya ishini olingan natija: 

 Dasturni ishga tushiring va natijalarni brauzerda ko‘rsating. 

 

VI. Laboratoriya ishini xulosasi: 

CSS qo'llanib, rasmlar va animatsiyalar uchun stil berishda qanday 

qo‘llanishlardan foydalandingiz, o‘zingizning shaxsiy dizaynlaringiz haqida 

tushunchalariz va tajribalariz haqida izoh bering 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  
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22-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: CSS DA MAKETLAR BILAN 

ISHLASH. 

II. Laboratoriya ishining maqsadi: Talabalarda maketlar bilan ishlash 

ko’nikmasini oshirish va mustaqil bajarib ko’rishiga imkoniyat yaratib berish. 

III. Laboratoriya ishi uchun kerakli jihozlar: Matn muharriri (Notepad++, 

Visual Studio Code yoki boshqa), Rasm fayllari (PNG, JPG, SVG yoki boshqa), 

Veb brauzer (Chrome, Firefox, Safari yoki boshqa) 

IV. Laboratoriya ishini o‘tkazish tartibi:  

1. HTML faylini yaratish: 

 HTML faylini yaratish va asosiy HTML taglarini qo'shing. 

2. Maket strukturasini tuzish: 

 Maketda (header, nav, main, aside, footer) strukturani tuzing. 

3. CSS faylini yaratish: 

 CSS faylini yaratish va unga bog'langan HTML faylini qo'shing. 

4. Header va footer qismi: 

 Header va footer qismlarini dizayn qiling. 

5. Nav va aside qismlari: 

 Navigatsiya (nav) va to'g'ri (aside) qismlarini dizayn qiling. 

6. Mavjud elementlarni qo'llash: 

 Mavjud HTML elementlarni qo'llash va ularni stil bering. 

7. Grid va flexbox: 

 Grid va flexboxni ishlatib maketni joylashtiring. 

8. Rasm va background qo'shish: 

 Rasmlarni (<img>) qo'shish va fono (background) qo'shing. 

9. Responsive design: 

 Responsive design prinsiplarini ishlatib maketni mobil qurilmalarga 

mos ravishda joylashtiring. 
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V. Laboratoriya ishini olingan natija: 

 Dasturni ishga tushiring va natijalarni brauzerda ko‘rsating. 

 

VI. Laboratoriya ishini xulosasi: 

CSS qo'llanib, maketlarni qanday qo‘llanishlardan foydalandingiz, 

o‘zingizning shaxsiy dizaynlaringiz haqida tushunchalariz va tajribalariz haqida 

izoh bering 

 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013 

2. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

3. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

4. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  
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23-LABORATORIYA ISHI 

I. LABORATORIYA MAVZUSI: CSS QO‘LLAGAN HOLDA WEB-

SAYT YARATISH 

II. Laboratoriya ishining maqsadi: Talabalarga CSS3 (Cascading Style 

Sheets Level 3) va HTML (HyperText Markup Language) orqali qo‘llangan holatda 

veb-sayt yaratishning asosiy qadamlarini o‘rgatish. 

III. Laboratoriya uchun kerakli jihozlar: Kompyuter, Chrome yoki Firefox 

brauzerlar, Notepad yoki Visual Studio Code dasturi 

IV. Laboratoriya ishini o‘tkazish tartibi:  

1. Veb-saytni strukturasini yaratish: 

 HTML faylini yaratish (masalan, index.html). 

 Faylda veb-sayt strukturasi uchun asosiy HTML taglarni qo‘llash 

(masalan, <html>, <head>, <title>, <body>, <header>, <nav>, <main>, 

<footer>, va hokazo). 

2. CSS faylini yaratish: 

 CSS faylini yaratish (masalan, style.css). 

 Faylda veb-sayt elementlariga xususiyatlarni berish (masalan, body { 

font-family: 'Arial', sans-serif; }, va hokazo). 

3. HTML va CSS fayllarni bog‘lash: 

 HTML faylida CSS faylini bog‘lash (<link> orqali). 

 

 

 

 

 

 

 

 

 



82 

 

4. Veb-saytni qo‘llash uchun stil berish: 

 Veb-saytning umumiy stilini belgilash uchun CSS faylida global 

xususiyatlar (masalan, body, a, p, va hokazo) berish. 

5. Veb-saytni dizayn qilish: 

 Header, navigation, main content, footer, va hokazo bo‘limlarga xususiy 

xususiyatlar bering. 

6. Ranglar va fonlar: 

 Elementlarga rang va fon berish uchun CSS qo‘llash. 

7. Mundarija va qisqa matnlar: 

 Sarlavha, chap panel, yana biror joyda bo‘lgan asosiy matnlar uchun 

xususiyatlar berish. 

8. Foto va rasm elementlari: 

 Rasm va foto elementlariga maxsus o‘lcham va joylashuv qoidalarini 

bering. 

9. Naviqatsiya tuzish: 

 Saytning navigatsiya qismiga yo‘l topish uchun menyu tuzish. 

10. Media-so‘zlash va responsive dizayn: 

 Kichik ekranlarga mos tuzilgan dizaynni amalga oshirish uchun media-

so‘zlashni qo‘llash. 

V. Laboratoriya ishini olingan natija: 

 Dasturni ishga tushiring va natijalarni brauzerda ko‘rsating. 

 Saytning murakkab yoki kichik ekrandagi shakl va dizayni sifatida qanday 

aks etadi?  
 

VI. Laboratoriya ishini xulosasi. 

Tuzilgan web saytni dizayn qilishda qanday qo‘llanishlardan foydalandingiz, 

o‘zingizning shaxsiy dizaynlaringiz haqida tushunchalariz va tajribalariz haqida 

izoh bering 

VII. Adabiyotlar:  

1. M.E.Mamarajabov, S.Q.Tursunov, L.M.Nabiulina “Kompyuter grafikasi 

va web dizayn” darslik. Toshkent, 2013. 

2. Z.T.Negmatulloyev. Algoritmik tillar va dasturlash fanidan o‘quv 

qo‘llanma.Toshkent, “NIF MSH” 2024. 

3. U.Yuldashev, M.E.Mamarajabov, S.Q.Tursunov “Web dizayn” uslubiy 

qo‘llanma. Toshkent, 2007 

4. U.A.Yuldashev, «Kompyuter grafikasi va Web dizayn», o‘quv qo‘llanma, 

Guliston, GulDU, 2022.  

5. U.A.Yuldashev, «Web dizayn», o‘quv qo‘llanma, Guliston, GulDU, 2022.  
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